
Section 4
Data Representation

and Change

The big idea in this section centers on how to represent and analyze
changes in temperature over time.

In the first activity, students make a graph of local high and low
t e m p e r a t u res.  They identify other locations in the United States
where the temperatures are most similar to and most different from
their own.  By hand, students construct line graphs to compare
patterns of highs and lows across three geographic locations.

Next, students analyze temperature data collected by the
StowAway™ data logger that was launched at the start of this  unit.
They use the computer to explore line graphs of the temperature
changes outside their classroom, calculate the amount and rate of
change between each high and low temperature, and answer
questions such as “Is the rate of change faster from the coldest
temperature to the hottest, or from the hottest to the coldest?”  and
“What is the relationship between the slope of the graph and the rate
of change?”

F i n a l l y, students write a narrative description of the temperature
over the last several weeks, drawing upon the data they have
collected with the StowAway™, their weather logs, and the
analytical techniques they have learned in this unit.  After
communicating via e-mail with their partner class, students compare
the temperature changes outside their own classroom with those
outside the classroom of their partner class.





How can the temperature fluctuations in students’ location best be
represented graphically?  Here students first interpret information
presented in line graphs.  They then construct line graphs of the high
and low temperatures they have been collecting.

• Students read and interpret line
graphs; they discuss scales, axes,
and labels.

• Students construct line graphs to
show changes in temperature over
time.

• Students use line graphs to
informally compare rates of change.

• Students use line graphs to
informally discuss slope.

Students will need five days’ worth of temperature data from other cities in the
United States.  You can provide five days of the USA Today weather page or get
data from Blue Skies daily for five days.

materials
1 copy of Reproducible Master 16 (Learning About Line Graphs) for each
student

1 copy of Reproducible Master 17 (Make Your Own Line Graph Story) for
each student

high/low temperature data from students’ weather logs

graph paper (1/4 inch)

rulers or straight edge

This activity will enable you to
assess students’ ability to construct
and interpret line graphs.  Use
Reproducible Master 16 as an
assessment of individual students'
ability to read and reason about data
shown in a line graph.

math goals ongoing assessment

advance preparation

Line Graphs10
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Teacher A
My students worked in groups of three.
Each group constructed a line graph of
minimum and maximum temperatures for
the previous week (Monday through
Friday).  When we were looking at all of
the graphs, one group mentioned that we
didn‘t really know exactly what all of the
temperatures were between the high for
Monday and the high for Tuesday.

We talked about how we didn’t know
whether the temperature fluctuated a lot
between days or whether it changed
smoothly.  In other words, a lot of data
were missing.  Most of the students felt this
was OK because we just wanted to show a
trend in the data.  A few students felt
uncomfortable with so much data missing.

I couldn’t have planned this better!  This
debate was the perfect setup for the next
lesson, using the data collected by the
StowAway™ data logger.

what students do
1. Using Reproducible Master 16

(Learning About Line Graphs),
students match events from a story
with points on a corresponding line
graph.  
This is an opportunity for students to
become more comfortable reading line
graphs and more familiar with the parts of a
line graph. 

2. Students construct a line graph of the
local high temperatures over the last
week.  
Also have students use the same grid to
construct a line graph of the local low
temperatures.  

3. Students compare and discuss the
construction and meaning of their
line graphs.
Ask students: 

• What range did you use on your scale?

• How many degrees are represented by
each grid mark on the graph paper?

• Did the high temperatures follow the
same pattern as the low temperatures?

Teachers'
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Teacher B
I gave my students one week to find
examples of line graphs in the media.  At
the end of the week, they gave mini–oral
reports about the graphs they
brought to class. They described
what each graph was about and
detailed the trends being represented
in each.  The sources that seemed to
be most fruitful were business
magazines and the business section
of the newspaper.  

After students had plenty of
experience constructing line graphs, I
had them go back to the graphs they
collected from newspapers and magazines
and focus on the scales used in the line
graphs.  How would the data look if larger
increments were used on the scale?  What if
the increments were smaller?  

Each student chose one graph and
constructed two new graphs of the same
data—one with a scale using larger
increments and the other with a scale using
smaller increments.  The students were
surprised that you can change the look of
the data (and therefore the message to the
reader) by changing the scale.  Students
then had fun finding misleading graphs in
the media.  [See Background Information
for more on line graphs and scales.]

4. Students find two other locations in
the United States that have
temperatures similar to and different
from their own.
Have students construct line graphs of the
high and low temperatures for the two
locations they chose.  Tell students to use
the same scale they used on the local graph.
For example:

5. Students compare patterns in the
three sets of line graphs.
Ask students to identify what similarities
and what differences they notice.

6. Using Reproducible Master 17 (Make
Your Own Line Graph Story) ,
students create their own line graphs
stories.

Stories
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background information
Constructing Line Graphs
To construct a line graph, first draw the horizontal and vertical
axes.  The horizontal axis typically shows the time period
covered by the data.  In the graph below, the time period is six
months—January through June—with one data point for each
month.  

The scale on the vertical axis indicates degrees Fahrenheit.  The
range is 0 to 100 degrees, and the scale is marked in 5-degree
intervals.  It is also important to label each axis and to title the
graph.

Scales on Line Graphs
It is useful to look at the scale on a line graph before you
interpret the data.  On the three line graphs shown on these
pages, the scale on the vertical axis indicates degrees
Fahrenheit.  The range of the scale is 0 to 100 degrees.  The scale
on the horizontal axis indicates time.  In these graphs, the time
period is six months, January through June.

If you wanted to change the look of the data, you could change
the scale on the vertical axis.  For example, to make differences
in the data appear smaller, use a larger range:

Mean High and Low Temperatures
in Kalamazoo, Michigan

January–June 1995

Mean High and Low Temperatures
in Kalamazoo, Michigan

January–June 1995
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To make differences in the data appear larger, use a smaller
range:

Any of these scales is appropriate, but as a reader one should
consider the scale being used and how it may change the
appearance of the data.

Interpreting Line Graphs
When interpreting a line graph, the reader is usually looking for
a trend over time.  In the Kalamazoo graph, it could be noted
that the trend is for the temperatures to go up from January
through June at a fairly consistent rate.  Another trend is for the
differences between the high temperatures and the low
temperatures to become greater during spring and into
summer.

Another thing to look for in a line graph is the size of the
changes between data points.  When did the greatest change
occur?

In the Kalamazoo graph, the greatest change in high
temperatures occurred between May and June.  The smallest
change occurred between January and February.  Similar
patterns can be seen in the low-temperature data.

Mean High and Low Temperatures
in Kalamazoo, Michigan

January–June 1995





How do the data recorded by the StowAway™ compare with the
data kept by students?  In this activity, students analyze temperature
data collected electronically outside their classroom over 18 days.
They examine a line graph of the data and mark the high
temperature, low temperature, and amount of change between
maximum highs and minimum lows.

• Students interpret line graphs and
discuss patterns in the data.

Students use the LogBook®
software to construct a line graph
and import data into a spreadsheet.

Students use the data from the
StowAway™ to create a table of
temperature highs, lows, and range.

• Students identify patterns and
trends in line graphs and tables.

• Students compare weather log data
with StowAway™ data. 

The StowAway™ data logger was set to collect temperature data at the
beginning of the unit for an 18-day period.  Download the temperature data
and print a line graph of the data.  (See Background Information for directions.)
Export the data to your spreadsheet and format and print the data.

Copy the Reproducible Master 18 (LogBook® Graph Overlay) onto an
overhead.  Put the overhead over a printout of the StowAway™ graph and
make one copy of the graph and the spreadsheet data for each student.

materials
overhead from Reproducible Master 18 (LogBook® Graph Overlay)

calculators

students’ weather logs

StowAway™ data logger/LogBook® software

Observations during this activity
and students’ work will enable you
to assess students’ ability to organize
and analyze temperature data.

math goals ongoing assessment

advance preparation

Exploring the StowAway™ Data11
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Teacher A
My students worked in groups of three in
the computer lab.  Each group downloaded
the data from the StowAway™ logger into
LogBook® and then into ClarisWorks.
This took almost the whole class period,
but I felt my students needed that
experience.

Students had various difficulties attaching
the StowAway™ to the computer.  Some
groups attached the gray cable to the
printer port instead of the phone port.
Other students didn’t make sure the
connections were tight by pressing the
cable firmly into the computer and the
StowAway™.  

Students all found the LogBook® software
pretty easy to use.  They were fascinated
when they ran the cursor around the graph
and saw the values displayed.  They were
also amazed at the variability of the
temperature over the 18 days.

After exporting the data (some groups had
trouble remembering to change the format
to Excel), students imported the data into
our spreadsheet application.  They were
confused by the long number shown in the
date column, but we changed the format of
the number to “Date & Time” and the table
made much more sense.

what students do
1. Students read and interpret the

StowAway™ line graph. 
Referring to the line graph, ask students
questions like the following:
• Was the temperature fairly consistent

during this period?
• What patterns do you notice?

• Did any unusual weather days occur
during this period?  If so, can you spot
them on the graph?  How?

• When did the greatest change in
temperature occur?

Suggest that students refer to their weather
logs as they look over the graph.

2. Students practice reading the
StowAway™ data from the
LogBook® software.
Ask students:
• What was the highest temperature for a

given date?  The lowest?
• At what time did the high temperature

occur?  

3. Students mark on the line graph the
times the high temperatures and low
temperatures occurred each day.  
Tell students they can find this information
in the spreadsheet.

4. Students make observations about
the graph and the temperature data.  
Encourage students to make observations
such as these:
• On most days, the temperature changed

about 40 degrees through the day.
• The highest temperature occurred on

September 1 at about 2:00 PM.; it was 105
degrees.

• The lowest temperature occurred on

Teachers'
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Teacher B
Several students noticed an odd pattern in
the StowAway™ graph.  On Tuesday
mornings, the temperature would climb
until 10:30.  Then it would drop 10 or 15
degrees, and quickly shoot back up 20
minutes later.  We speculated that clouds
covered the sun or a cold wind always
blew at that time, but nobody thought
those were likely explanations.  Finally,
Jennifer suggested that the cafeteria might
get a delivery then and the truck could be
blocking the StowAway™ probe from the
sun.  The following Tuesday at 10:30, we
checked—there was the truck! 

September 10 at about 5:00 AM; it was 45
degrees.

• During the first week of September the
highest temperatures were all in the 90s
or low 100s, but during the second week
the highs were in the 80s or low 90s.

5. Students mark their graphs with data
they recorded in their weather logs.
If students notice discrepancies between the
StowAway™ data and the temperatures
they recorded in their weather logs, ask
them to think about why the discrepancies
might have occurred.  

6. Students create a data table to record
the high temperature, low temper-
ature, and range for each day.  
Also have students record the time the high
and low temperatures occurred.  For
example:

7. Students look for patterns in the data.  
You may find that students make
observations such as the following:
• The high temperatures occur around 3:00

to 3:30 each afternoon.
• The low temperatures occur around 4:00

or 5:00 in the morning.
• The range between the high and low

temperatures was almost 50 degrees on
September 4.

Stories

Date 9/1 9/2 9/3 9/4 9/5 9/6 9/7

Low 70° 64° 52° 51° 59° 64° 60°

4:34AM 5:01 AM 5:12 AM 4:38 AM 5:06 AM 5:22 AM 5:10 AM

High 105° 93° 96° 100° 97° 100° 97°

3:33 PM 3:48 PM 3:30 PM 2:39 PM 3:41 PM 3:09 PM 2:35 PM

Range 35 29 44 49 38 36 37
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background information
Downloading Data from the
StowAway™
To download the data from the StowAway™ data logger, plug
the data logger into the gray cable and then plug the other end
of the gray cable into the modem port of your Macintosh or the

DB-9 serial port of your IBM-compatible.
Start up the LogBook® software.  The
menu will show File   Edit   Logger

Views   Windows.  Pull down the Logger
menu and select the Readout option.  After
10 or 15 seconds, a graph of your data will
be displayed and a dialog box allowing it
to be saved will appear over it.  Name
your data and save the file.  A graph like
the one shown here will appear.

Students can zoom in on the plot to get a closer look at the data
by drawing a selection box around the section they'd like and
clicking in the box or selecting Zoom In on the View menu.  To
zoom out, select Zoom Out from the View menu.

On the Macintosh, students can use the Show Plot Info

command under the Windows menu in LogBook® to closely
examine their graphs.  This command brings up the Plot Info
Window, which shows start time, stop time, minimum recorded
temperature, and maximum recorded temperature.  It also
shows the plot information (time and temperature) pertaining
to the mouse location.  Students can place the cursor anywhere
on the graph to obtain numerical readings.

To download the StowAway™ data for use in other data
manipulation packages (like Microsoft Excel or ClarisWorks),
pull down the File menu and select Export Setup.  Click on the
desired export format button and click on OK.  Then pull down
the File menu again and select Export Plot Data.  Type in the
name you want to give your data set and click on OK.  The data
set is now saved in a file that can be used in another software
package.
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How fast did the temperature change each day from coldest to
hottest over the last two weeks?  From hottest to coldest?  In this
activity, students calculate the rate of change from the low
temperature to the high temperature for each day and compare the
rates.  They also examine the temperature changes using the data
recorded in their weather logs.  Finally, they explore what events
caused the rate of change to increase, decrease, or remain constant.

• Students calculate the rate of
change between high and low
temperatures.

• Students explore the meaning of a
positive (or negative) rate of
change.

• Students relate rate of change to the
slope of a line in a line graph.

• Students compare rates of change.

• Students write about data collected
outside the classroom using the
StowAway ™, noting patterns in
the data.

materials
calculators

copies of the StowAway™ graph, spreadsheet data, and students’ graphs
from Activity 11

Your observation of students’ group
work will inform you about their
ability to calculate rates of change.
Students’ written narratives will
help you evaluate their
understanding of the relationship
between their own observational
data and data represented in a
StowAway™ line graph.

math goals ongoing assessment

advance preparation
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Teacher A
Before we even got to do rates of change,
my students made two interesting
discoveries from the StowAway™
temperature data.  First, they seemed
surprised that the coldest point of the day
was usually 5:00 AM; they thought it
would be closer to midnight.  Second, they
noticed that it took less time to warm up
(go from coldest to hottest) than it did to
cool down.  At this point, we decided to e-
mail our partner class to see if this was true
there too.

When our partner class replied to our
message, we learned that its data showed
that it took about the same amount of time
to cool down as to warm up (about 12
hours each).  Now, we all began to wonder
why.

what students do
1. Students calculate the rate of change

from coldest temperature to hottest
temperature for a day.
Choose one day from the StowAway™ data.
Ask students to calculate the rate of change
from the coldest temperature to the hottest
temperature (see Background Information).  

2. Students calculate the average rate of
change from the hottest temperature
to the coldest temperature for the
day.

3. Students compare the rates of change.
Ask students:  
• Does it take longer to warm up (go from

coldest to hottest) or to cool down (go
from hottest to coldest)?

• Do you think this is true for every day?  

4. Students calculate the rates of change
for each day logged by the
StowAway™.
You may want students to work in groups,
with each group responsible for several
days of data.

5. Students compare the rates of change
with the slopes of the graph for each
day.
Ask students:

• What is the relationship between the rate
of change and the slope of the graph?  

• When the slope is steeper, is the rate of
change faster or slower?

• Can you predict the rate of change by
looking at the slope?  If so, how?

Teachers'
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Teacher B
Two students were so interested in the
StowAway™ that I invited them to work
together and plan a final project using data
loggers.  They decided to find out whether
the temperatures and the pattern of change
were different in different parts of town.
We have two StowAway™s, and so they
were able to take them home.  One student
lives in a house shaded by many trees; the
other, in a south-facing apartment.  Before
they launched the StowAway™ loggers, I
had them write their expectations about
how the patterns would compare.  It will
be interesting to see what they find out.

6. Each student writes a narrative
description about the temperature
outside the classroom for the time
period recorded by the StowAway™
logger.  
Direct students to use data collected in their
weather logs, the StowAway™ graph, and
any other information they have collected.
In their narratives, students should address
questions like the following:
• Did a pattern of daily change occur across

the whole period?
• Did you find blocks of days that seemed

to have a common pattern?  If so, what
was the pattern?

• Did some days show a different pattern?
If so, which days were they?  How were
they different?  Can you explain the
reasons for the difference?  Could you
remember what the weather on that day
was like, without looking in the log?

• Would you expect to see the same
patterns at a different time of year?

7. Students share and discuss their
narratives.

8.  Students e-mail their partner class
and exchange StowAway™ data files.  
Encourage students to compare the line
graphs for both locations and to discuss
similarities and differences.

Stories
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background information
Rate of Change
The average rate of change is the amount of change that occurs
in a given time period.  For the purposes of this unit, students
will be calculating  changes in temperature over hours or days.  

For example, if the high temperature is 65 degrees Fahrenheit at
3:00 PM and the low is 22 degrees Fahrenheit at 5:00 AM, the
range is 43 degrees.  The temperature changed 43 degrees from
5:00 AM to 3:00 PM—a 10-hour period.  So, the rate of change is
as follows:

43° ÷ 10 hours = +4.3°/hour

The temperature increased at an average rate of 4.3 degrees per hour.

When rate of change is used to describe a decrease in
temperature, the rate of change should be reported as a
negative value.

For example, if the temperature changed –43 degrees from 3:00
PM. to 5:00 AM—a 14-hour period—then the average rate of
change is as follows:

–43°/14 hours = –3.07°/hour

The temperature decreased at an average rate of 3.07 degrees per hour. 

Slope and Rate of Change
The slope of a line is a measure of its steepness.  For example, in
the graph shown below, Lines a, b, c, and d have different
slopes.

The slope of a line tells us whether the rate of change was
relatively fast or slow.  The steeper the slope, the faster the rate
of change.  Line a in the graph above shows the fastest rate of
change; Line b shows a slower rate of change.  The direction of

a

b

c

d

12:00 1:00

Time of Day

Temperature (F)

70

68

66

64

62
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the slope tells us whether the change was a positive or a
negative one.  Lines a and b show positive changes, from cooler
to warmer; Line d shows a negative change.  Line c , which is
parallel to the x-axis, shows that there was no change at all. 
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E-Mail Your
Partner Class

1. Students send their description of the temperature
outside their classroom for the past two weeks to
their partner class.
If possible, have students enclose the data file that was
exported from the StowAway™.

2. When they receive the data from their partner
class, students discuss the differences between
their partner class’s temperatures and their own.
If the partner class has included a data file, print out the
graph and have students compare it with their own.

3. Students formulate and send questions about their
partner class’s data.

4. Students reply to their partner class’s questions.
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Were the predictions made by forecasters at USA Today for
yesterday's high temperature correct?  In this activity, students
gather data about yesterday's high temperatures around the nation
and make a temperature map to graphically display their findings.
They compare their map of the actual high temperatures with that of
the predicted ones and try to explain any differences they find.

• Students read and interpret a
temperature map and discuss
legends, labels, patterns, and
differences between predicted and
actual high temperatures.

Students use computers to gather
data about high temperatures in
selected cities and compare the
actual high temperatures with the
predicted highs.

• Students represent national highs as
color bands on a map.

• Students construct a temperature
map of the United States and
compare actual to predicted highs
for the day.

• Students discuss reasons for
differences between predicted and
actual temperatures.

Obtain at least one copy of the weather page of USA Today from the past two
days.

materials
Reproducible Masters 19–24 (regions of the United States) and 25–30 (city
codes)

This activity is an opportunity for
you to evaluate students'
collaborative problem solving as
they construct temperature maps
and compare them with a published
temperature map for the same time
period.

math goals ongoing assessment

advance preparation
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Teacher A
A couple of the groups in my class had
heated debates about how many cities they
should sample in order to make their maps.
The group in charge of the Northeast
region decided to plot data from all of the
cities in the region because the number of
cities there is relatively few.  But the group
with the Southwest region had exactly the
opposite problem, with 36 possible cities in
California alone.  They finally decided they
should divide the states in their region into
zones and make sure they sampled data
from each of the zones.  For example, they
divided California into 10 zones and
sampled data from one city in each of those
zones.  They felt that getting data from
each of the cities they chose would allow
them to paint an accurate picture of the
temperatures in their region.

what students do
1. Students read information from a

color temperature map (such as the
maps in USA Today).  
Ask questions like the following:
• What information is this map giving us?

• What does the legend indicate?
• What do the numbers represent?

• How many temperature bands are
represented on the map?

• What might explain some of the patterns?
• How would an actual high-temperature

map compare with this map of predicted
temperatures?

2. Students discuss how a temperature
map might be constructed.
Encourage students to think about what
quantity of data points might be required to
make an accurate representation and in
what way the temperature regions might be
delineated.

3. Groups of students gather yester-
day’s high-temperature data for six
regions of the United States:
Northeast, Midwest, Northwest,
Southwest, Southern Plains, and
Southeast.
Give each group one copy of the
reproducible master for its region
(Reproducible Masters 19–24) and the city
codes for that region (Reproducible Masters
25–30).  Instruct the groups to decide how
many cities (from those available on-line)
they will include in their set of data in order
to make an accurate representation of their
region’s temperature data.  Then ask the
groups to locate and mark the cities they
chose on their regional maps.  

Teachers'
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Teacher B
Once they had completed coloring the class
map, my students compared it with the
USA Today forecast map.  They
immediately saw many differences
between their map and the forecast map.
Many students saw slight differences that
they attributed to errors in their
demarcation strategies.  But the actual
temperatures in the Midwest were
considerably lower than the predicated
ones.  Students were all very excited that
the predictions were not completely
correct.

4. Students learn how to log in to UM-
Weather Using Telnet to view temper-
ature data for the preceding day.
See Background Information for
instructions.

5. Using colors that match the USA
Today legend, students color-code
their regional maps.
Remind students of the earlier discussion
about how to make a temperature map.
Encourage them to work together to decide
how to draw the boundaries for each
temperature region.

6. Students cut and paste their regional
maps in order to make a class map of
the entire country.
Ask students:  What method did you use to
delineate regions?  Did the number of cities
sampled seem to affect the construction of
the temperature bands?

7. Students discuss the differences and
similarities between their map and
the map of yesterday’s USA Today
predictions.
Ask students questions like the following:
• In what ways does your map resemble

the predictions?  
• In what ways does it differ?  

• Why do you think the differences
occurred?  

Help students consider how their methods
may have differed from the method used by
the map makers.  Or perhaps the
predictions were incorrect.

Stories
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background information
Weather Maps
A weather map is an analyzed chart that depicts weather
conditions over an area at a particular time.  In this unit,
students construct temperature maps—weather maps with only
temperature data.

Below is one example of a temperature map from the Blue Skies
software.

In the above representation, temperatures are marked by
numerals in many locations, but the overall patterns of the
temperatures in the United States are shown by colored bands,
each representing a different temperature range.

In the United States, on the day the above map was generated,
the temperatures ranged from the lows of 35 to 40 degrees in
the southeastern corner of Oregon to the highs of 85 to 90
degrees in the southeastern part of the country and in the
southeastern California/southwestern Arizona region.
Temperatures are generally cooler from southeast to northwest,
although some fluctuations in this trend occur in the middle of
the country.
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Launching UM-Weather Using Telnet
From the Window to Blue Skies menu, launch UM-Weather
Using Telnet by clicking on the icon (at right).  The Telnet
program will load and access the UM Weather site.

Press <RETURN> and select 1 (U.S. forecasts and climate data)
from the WEATHER UNDERGROUND MAIN MENU.

Select 2 (Print climatic data for selected city).  
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Using the city codes on Reproducible Masters 25–30, choose a
city from which you’d like climatic data.  For example, the
screen below represents data from Casper, Wyoming, on
January 10, 1996.  The HIGH YESTERDAY is the important
piece of data for students to recognize.  Some students might
want to keep track of other pieces of information.
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Students use the Section 4 Quiz, found at the end of the
collection of Reproducible Masters, for this assessment.

Assessment Goals
The items in this assessment test students’ ability to construct
and interpret data displays.  To perform well on this
assessment, students should be able to

• construct bar graphs of data with positive and negative
values,

• construct line graphs, and

• interpret data presented in bar and line graphs.

Answer Key
Many good answers are possible for these open-ended
questions.  A scoring rubric is in development.  Shown below
are examples of the kinds of graphs students should make,
along with answers to questions related to the data displays.

1a. A line graph is useful for showing
change in temperature over time,
as in the adjacent example.

1b. The temperature was dropping;
then it shot up and stayed high for
at least 8 minutes.  It dropped back
down to where it was before for at least 8 minutes; then it
shot up again for at least another 16 minutes.  Then it
dropped even lower than ever.

1c. The dog might have been in the doghouse between 3:38
and 4:02 and between 4:10 and 4:42.  Or maybe the sun was
very strong at those times, but something blocked the sun
from the doghouse the other
times. 

2a. A bar graph is useful for
comparing temperatures at
different locations, as in the
adjacent example.

2b. Meltopolis.

2c. Phoester.
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